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Overview

Products Supported

This User Guide provides device driver installation for the Windows 2000 
operating system and configuration information for the following products:
• RocketPort EXPRESS
• RocketPort EXPRESS SMPTE
• RocketPort INFINITY
In the remainder of this User Guide, the products are merely referred to as 
RocketPort EXPRESS, RocketPort EXPRESS SMPTE, and RocketPort INFINITY.

Downloading the Latest Software and User Guides

You can use the CD or the following table to locate the latest version of the 
software and documentation for the RocketPort EXPRESS, RocketPort EXPRESS 
SMPTE, and RocketPort INFINITY from the Comtrol ftp site.

Product
 Driver, 

Applications, 
and 

Documents
Location

RocketPort 
EXPRESS

Device Driver ftp://ftp.comtrol.com/html/rp_express_drivers.htm

Diagnostics 
and Utilities ftp://ftp.comtrol.com/html/rp_express_diag.htm

User Guides ftp://ftp.comtrol.com/html/rp_express_docs.htm

RocketPort 
INFINITY

Device Driver ftp://ftp.comtrol.com/html/rp_infinity_drivers.htm

Diagnostics 
and Utilities ftp://ftp.comtrol.com/html/rp_infinity_diag.htm

User Guides ftp://ftp.comtrol.com/html/rp_infinity_docs.htm

RocketPort 
EXPRESS 
SMPTE

Device Driver ftp://ftp.comtrol.com/html/rp_express_smpte_drivers.htm

Diagnostics 
and Utilities ftp://ftp.comtrol.com/html/rp_express_smpte_diag.htm

User Guides ftp://ftp.comtrol.com/html/rp_express_smpte_docs.htm
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Initial Driver Installation

Review Preparing for Driver Installation and Driver Installation (below) before 
installing the driver.

Preparing for Driver Installation

If you have not done so, use this procedure to prepare for the driver installation:
1. Unzip the latest driver assembly to a location that is available to the host. You 

can use one of the following methods to access the device driver.
• Links to the latest files on the ftp site in Downloading the Latest Software 

and User Guides on Page 5.
• The CD shipped with the RocketPort EXPRESS, RocketPort EXPRESS 

SMPTE, and RocketPort INFINITY contains links to check the driver 
version on the CD against the Comtrol ftp site for the latest driver or 
documentation.

2. Install the adapter and connect the interface. If you need hardware 
installation procedures, see Downloading the Latest Software and User 
Guides on Page 5). 
Note: Install new RocketPort EXPRESS, RocketPort EXPRESS SMPTE, and 

RocketPort INFINITY adapters one at a time to minimize installation 
problems.

 
Do not connect RS-422/485 devices until the appropriate port interface 
type has been configured in the device driver. The RocketPort EXPRESS, 
RocketPort EXPRESS SMPTE, and RocketPort INFINITY default port 
setting is RS-232.

Driver Installation 

After installing the adapter, a Found New Hardware message starts the driver 
installation for the RocketPort EXPRESS, RocketPort EXPRESS SMPTE, and 
RocketPort INFINITY on most Windows operating systems when you apply power 
to the system. When the new driver is installed, the system loads default COM 
ports. You may need to configure the RocketPort EXPRESS, RocketPort EXPRESS 
SMPTE, and RocketPort INFINITY COM ports (Page 13) for your serial device or 
RocketPort EXPRESS, RocketPort EXPRESS SMPTE, and RocketPort INFINITY 
properties (Page 17).
After driver installation and configuration, connect the serial devices to the ports. 
For information about the RocketPort EXPRESS, RocketPort EXPRESS SMPTE, 
and RocketPort INFINITY connectors, refer to the appropriate User Guide (Page 
5).
 
Do not connect RS-422/485 devices until the appropriate port interface 
type has been configured in the driver. The RocketPort EXPRESS, 
RocketPort EXPRESS SMPTE, and RocketPort INFINITY default port 
setting is RS-232.

Caution

Caution
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 Initial Driver Installation 
1. If you have not done so, copy the driver assembly to your hard drive and 
extract it to a temporary location. 

2. Click Next at the Found New Hardware Wizard.
3. Click Display a list of the known drivers for this device so that I can choose a specific 

driver and then click Next.
4. Click Multi-port serial adapters and then click Next.
5. Click Have Disk.
6. Click Browse and select the directory where the driver files are located and 

then click Open.
7. Click OK when Install from Disk dialog reappears.
8. Select the appropriate RocketPort EXPRESS, RocketPort EXPRESS SMPTE, 

and RocketPort INFINITY model from the list and then click Next.
9. Click Next on the Start Device Driver Installation dialog.
10. If necessary, click Yes if the Digital Signature Not Found dialog appears to 

complete the driver installation.
11. Click Finish. The driver is installed and the system will start configuring the 

RS-232 COM ports. 
12. Click Finish to complete the driver installation process.
13. Click Ok to restart the system so that the changes take effect.
14. Click Yes to restart the computer. 
15. To install an additional adapter, power the system down, install a RocketPort 

EXPRESS, RocketPort EXPRESS SMPTE, and RocketPort INFINITY, and 
power on the system. The driver installs automatically.

16. Configure the COM ports for your serial devices (Page 13) or RocketPort 
EXPRESS, RocketPort EXPRESS SMPTE, and RocketPort INFINITY adapter 
properties (Page 17).

After driver and adapter configuration, connect your serial devices to the 
RocketPort EXPRESS, RocketPort EXPRESS SMPTE, and RocketPort INFINITY 
ports. For information about RocketPort EXPRESS, RocketPort EXPRESS 
SMPTE, and RocketPort INFINITY connectors, see the appropriate User Guide 
(Page 5).
If the attached serial device is a plug and play device, Windows 2000 
automatically detects and installs or allows you to locate the driver or drivers for 
your serial devices. 
If the serial device is not a plug and play device, see Configuring Non-Plug and 
Play Devices on Page 27.
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Updating the Driver

Use the following procedure to update the device driver for an existing Windows 
2000 host.
1. If necessary, download and extract the latest driver (Page 5).

2. Use the Device Manager to disable the RocketPort EXPRESS, RocketPort 
EXPRESS SMPTE, and RocketPort INFINITY.
a. On the Windows desktop, right-click the My Computer (or Computer) icon 

and then click Manage.
b. Click Device Manager.
c. Double-click Multi-port serial adapters to expand the view.
d. Right-click the RocketPort EXPRESS, RocketPort EXPRESS SMPTE, and 

RocketPort INFINITY and then click Disable.
e. Click Yes when queried, Do you really want to disable it?

Note: If you have multiple RocketPort EXPRESS, RocketPort EXPRESS SMPTE, 
and RocketPort INFINITY adapters installed, disable each adapter in the 
system.

3. Click Display a list of the known drivers for this device so that I can choose a specific 
driver and then Next.

4. Click Have Disk, browse to the driver location, Open, and then OK. 
5. Select the RocketPort EXPRESS, RocketPort EXPRESS SMPTE, and 

RocketPort INFINITY hardware description from the Models list and then 
click Next.

6. Click Next to start the driver update process.
7. If necessary, click Yes at the Digital Signature Not Found dialog.
8. Click Finish to complete the driver update.
9. Click Close in the RocketPort EXPRESS, RocketPort EXPRESS SMPTE, and 

RocketPort INFINITY Properties dialog
10. Click Ok to restart the system so that the changes take effect.
11. After restarting the host, use the Device Manager to enable the RocketPort 

EXPRESS, RocketPort EXPRESS SMPTE, and RocketPort INFINITY. 
To enable the RocketPort EXPRESS, RocketPort EXPRESS SMPTE, and 
RocketPort INFINITY, use Step 2a through d (above), and click Enable for 
each disabled adapter.

After restarting the system, you can re-configure the ports (Page 13) or change 
device options (Page 17), if necessary. 
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Adding an Adapter (Existing 
Installation)

If you have a RocketPort EXPRESS, RocketPort EXPRESS SMPTE, and 
RocketPort INFINITY installed and configured in your system, make sure that 
you have the latest driver before installing any new RocketPort EXPRESS, 
RocketPort EXPRESS SMPTE, and RocketPort INFINITY adapters. If necessary, 
use Updating the Driver on Page 9 to update the existing driver.
After updating the driver, install the new RocketPort EXPRESS, RocketPort 
EXPRESS SMPTE, and RocketPort INFINITY adapter. If you need hardware 
installation procedures, see the appropriate User Guide (Page 5).
Note: If you are adding multiple RocketPort EXPRESS, RocketPort EXPRESS 

SMPTE, and RocketPort INFINITY adapters, Comtrol recommends adding 
them one at a time.

Do not connect RS-422/485 devices until the appropriate port interface 
type has been configured in the driver. The RocketPort EXPRESS, 
RocketPort EXPRESS SMPTE, and RocketPort INFINITY default port 
setting is RS-232.

The new RocketPort EXPRESS, RocketPort EXPRESS SMPTE, and RocketPort 
INFINITY installs automatically after powering on the system. You may need to 
configure COM port properties (Page 13) for your applications or serial devices or 
the RocketPort EXPRESS, RocketPort EXPRESS SMPTE, and RocketPort 
INFINITY adapter properties (Page 17).

• Configuring COM Port Properties on Page 13
• Configuring Device Properties on Page 17

Caution
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Configuring COM Port Properties

Advanced and standard COM port configuration procedures are discussed in this 
section.
• Advanced COM port configuration using the Port Setup tab (below) for the 

RocketPort EXPRESS, RocketPort EXPRESS SMPTE, and RocketPort 
INFINITY port. You may need to change one or more of the default values to 
match your serial device. 

• Standard COM port configuration using the Port Settings tab (Page 16) if you 
need to change any of the default COM port parameters.

If you want to change the starting COM port number on the RocketPort 
EXPRESS, RocketPort EXPRESS SMPTE, and RocketPort INFINITY, see 
Configuring Device Properties on Page 17.
Do not connect RS-422/485 devices until the appropriate port interface 
type has been configured in the driver. The driver default port setting is 
RS-232.

Advanced COM Port Configuration

Use the following procedure to change COM port properties on a RocketPort 
EXPRESS, RocketPort EXPRESS SMPTE, and RocketPort INFINITY port or 
ports.
1. Access the Main Setup tab for the RocketPort EXPRESS, RocketPort EXPRESS 

SMPTE, and RocketPort INFINITY using the Device Manager.
a. On the Windows desktop, right-click the My Computer (or Computer) icon 

and then click Manage.
b. Click Device Manager.

2. Double-click Multi-port serial adapters to expand the view.
3. Double-click the RocketPort EXPRESS, RocketPort EXPRESS SMPTE, and 

RocketPort INFINITY that contains the COM ports you want to configure.

Field Default

RS mode RS-232

Override and lock baud rate to None

Timeout on transmit data on port close 0

Map CD to DSR Disabled

Map 2 stop bits to 1 Disabled

Wait on physical transmission before 
completing write Disabled

Emulate modem hardware RING signal Disabled

Block PnP search for attached serial device Disabled

Clone Disabled

Caution
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 Configuring COM Port Properties 
4. Select the Main Setup tab, highlight the COM port you want to configure, and 
then click Properties.

5. Enable the features (Page 20) you want to use, such as setting the appropriate 
communications mode for your serial device.

Note: You can use the “What’s this?” help to find information about each 
option.

Displays default values
14 - Advanced COM Port Configuration Driver Installation Guide for Windows 2000: 2000467 Rev. C



 Configuring COM Port Properties 
6. If the device is RS-485, you may 
need to configure RS-485 for your 
serial device.
a. Click the RS-485 tab.
b. Click the features (Page 22) 

that correspond to your serial 
device.

7. Click OK after configuring this 
port or click the Clone check box 
to set all of the ports on this 
RocketPort EXPRESS, 
RocketPort EXPRESS SMPTE, 
and RocketPort INFINITY to 
these characteristics.
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 Configuring COM Port Properties 
Standard COM Port Configuration

Use the appropriate procedure for your operating system if your application does 
not set COM port properties. 
If the application sets COM port properties, those settings take precedence over 
the standard COM port settings. The exception to this guideline is if you use the 
Override and Lock Baud Rate advanced COM port setting (Page 20).
Use the following procedure to change standard COM port parameters default 
values (Page 25).
1. Access the Device Manager.

a. On the Windows desktop, right-click the My Computer (or Computer) icon 
and then click Manage.

b. Click Device Manager.
2. Double-click Ports (COM & LPT) to expand 

the view.
Note: RocketPort EXPRESS, RocketPort 

EXPRESS SMPTE, and RocketPort 
INFINITY are displayed as Comtrol 
RocketPort Unity ports. in the Device 
Manager.

3. Double-click the RocketPort EXPRESS, 
RocketPort EXPRESS SMPTE, and RocketPort INFINITY COM port for 
which you want to change port parameters.

4. Click the Port Settings tab.
5. Make any necessary changes for 

the port.
6. Repeat this process for each port 

you that you need to change the 
COM port parameters.
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Configuring Device Properties

You may want to change the device Name or the Starting COM Port number on the 
RocketPort EXPRESS, RocketPort EXPRESS SMPTE, and RocketPort INFINITY. 

Accessing the Properties Page with the Device Manager

To change RocketPort EXPRESS, RocketPort EXPRESS SMPTE, and RocketPort 
INFINITY or COM port configuration, you need to access the Properties page for 
that RocketPort EXPRESS, RocketPort EXPRESS SMPTE, and RocketPort 
INFINITY. 
Note: You must be logged in with Administrator privileges to access the Device 

Manager.
1. Access the Main Setup tab for the RocketPort EXPRESS, RocketPort EXPRESS 

SMPTE, and RocketPort INFINITY using the Device Manager.
a. On the Windows desktop, right-click the My Computer (or Computer) icon 

and then click Manage.
b. Click Device Manager.
c. Double-click Multi-port serial adapters to expand the view.
d. Double-click the appropriate RocketPort EXPRESS, RocketPort EXPRESS 

SMPTE, and RocketPort INFINITY adapter.
2. Click the Main Setup tab.
3. Highlight RocketPort EXPRESS, RocketPort EXPRESS SMPTE, and 

RocketPort INFINITY device name and then click Properties. 
Make the desired changes:
• Change the device name.

The name that you assign is 
not saved until you click OK 
to exit the Main Setup tab. 
The new device name may not 
be present itself until the 
Device Manager is closed and 
reopened. 

• Click the starting COM port 
number in the drop list for 
this RocketPort EXPRESS, 
RocketPort EXPRESS 
SMPTE, and RocketPort 
INFINITY.

4. After making your changes, click 
OK and follow any other driver 
prompts.
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Configuration Screens

Use the Device Manager to access the RocketPort EXPRESS, RocketPort 
EXPRESS SMPTE, and RocketPort INFINITY driver Main Setup tab, if you need 
to change configuration of the default (Page 22) advanced COM port settings.
Use the Device Properties dialog to rename the RocketPort EXPRESS, RocketPort 
EXPRESS SMPTE, and RocketPort INFINITY, or change the starting COM port 
number.

Main Setup Tab

The Main Setup tab for the 
RocketPort EXPRESS, RocketPort 
EXPRESS SMPTE, and 
RocketPort INFINITY is accessed 
through the Device Manager.
1. On the Windows desktop, 

right-click the My Computer (or 
Computer) icon and then click 
Manage.

2. Click Device Manager.
3. Double-click Multi-port serial 

adapters to expand the view.
4. Double-click the RocketPort 

EXPRESS, RocketPort 
EXPRESS SMPTE, and 
RocketPort INFINITY that 
contains the COM ports you 
want to configure.

5. Click the Main Setup tab to 
access the following RocketPort 
EXPRESS, RocketPort 
EXPRESS SMPTE, and RocketPort INFINITY configuration screens:
• COM Port Properties for a COM port configuration. Highlight the COM port 

that you want to configure and then click Properties.
• Device Properties to change the name of the RocketPort EXPRESS, 

RocketPort EXPRESS SMPTE, and RocketPort INFINITY or the starting 
COM port number of the RocketPort EXPRESS, RocketPort EXPRESS 
SMPTE, and RocketPort INFINITY. 
Highlight the RocketPort EXPRESS, RocketPort EXPRESS SMPTE, and 
RocketPort INFINITY adapter that you want to configure and then click 
Properties.
Driver Installation Guide for Windows 2000: 2000467 Rev. C Main Setup Tab - 19



 Configuration Screens 
Port Setup Tab

The Port Setup tab is used to 
configure advanced COM port 
properties. See Advanced COM 
Port Configuration on Page 13 for 
configuration procedures.
After configuring a port, you can 
use the Clone feature to set all of 
the ports on the RocketPort 
EXPRESS, RocketPort EXPRESS 
SMPTE, and RocketPort 
INFINITY to these 
characteristics.

COM 
Properties Description

 
 
RS Mode

Use this drop list to select the 
communications mode for the serial device 
that you will be connecting to this port.
If you click RS-485, you may need to change 
settings on the RS-485 tab.

 
 
 
Override and 
lock baud 
rate to

This option allows you to lock selected 
ports.
You can select a value from the drop list or 
enter an appropriate value from the 
following standard baud rates: 300, 600, 
1200, 1800, 2400, 3600, 4800, 7200, 9600, 
14400, 19200, 38400, 57600, 115200, 
230400, 460800, or 921600. 
The Quad/Octacable models support up to 
921.6Kbps and the 8/16/32-port models 
with an interface box support up to 
460.8Kbps.
After locking a baud rate, no matter what 
baud rate is selected in a host application, 
the actual rate used is the rate specified 
here.
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 Configuration Screens 
 
Timeout on 
transmit 
data on port 
close

This option allows you to select the length 
of time to wait for data to clear the transmit 
buffer after a host application has closed 
the port. This is typically used with serial 
devices such as printers, to give the data 
sufficient time to flush through the system.

 
 
 
Map CD to 
DSR

This option is used in installations where 
there is no connection to the port’s DSR 
input.
Click this check box to cause the CD input 
to appear as DSR to the host application, 
and to perform hardware handshaking with 
CD rather than DSR.

 
 
Map 2 stop 
bits to 1

If your application is hard-coded to use two 
stop bits and you receive framing errors, 
click this check box to map 2 stop bits to 1 
bit. 
Leave this check box blank to enable stop 
bits to pass through unchanged.

 
 
Wait on 
physical 
transmission 
before 
completing 
write

This option forces all write packets to wait 
until the transmit data has physically 
completed the transmission before 
returning completion to the host 
application. 
The default mode (check box not clicked) is 
to buffer the data in the transmit hardware 
buffer, and return completion as soon as the 
packet is in the buffer.

 
 
Emulate 
modem 
hardware 
RING signal

Click this check box to emulate the ring 
indicator signal. 
If this box is checked and the port receives a 
RING signal (or an alternate code, as 
defined in the AT command set for the 
modem), it sends an RI signal to the 
communications application.

 
Block PnP 
search for 
attached 
serial device

This option disables plug and play from 
searching for a device attached to the serial 
port.
For example, data received during device 
discovery on a device is assumed to be a 
mouse to plug and play.

Clone: Apply 
all the 
settings to all 
ports

If this check box is not clicked, changes 
apply to the selected port only. 
If this check box is clicked, changes apply to 
all ports on this board.

COM 
Properties Description
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 Configuration Screens 
RS-485 Tab

The RS-485 tab allows you to 
configure RTS (Request to Send) 
options for RS-485 mode in the 
following situations:
• If your communications 

application does not toggle RTS 
when transmitting in RS-485 
mode.

• If you are using an external RS-
232 to RS-485 converter attached 
to a port configured in RS-232 
mode.

• RS-485 Mode provides these 
choices:
- Half-duplex (default) supports 

transmit and receive data. 
The 485txe signal is active to 
enable the driver portion of 
the connected RS-485 
transceiver which generates the RS-422 transmit data signals.

- Full-duplex (Master), supports transmit and receive data. The driver 
portion of the connected RS-485 transceiver is enabled by the 485txe 
signal. This mode is the same as RS-422.

- Full-duplex (Slave), supports transmit and receive data. The driver portion 
of the connected RS-485 transceiver is enabled by the 485txe signal when 
the RTS signal is active.

Note: Modem control lines are not supported when using RS-485 mode.
• Override and lock to RTS toggle mode allows you to lock the port in RTS 

(Request to Send) toggle mode, then set the mode (low or high) as desired for 
RS-485 mode.

• RTS Toggle RTS Low allows you to toggle the RTS output signal low during 
data transmission, which may be needed for relay devices for RS-485. 

 
 
 
 
 
 
 
 
Defaults

Click this to return to the driver default 
values.
• RS mode = RS-232
• Override and lock baud rate to = None
• Timeout on transmit data on port close = 0
• Map CD to DSR = Disabled
• Map 2 stop bits to 1 = Disabled
• Wait on physical transmission before 

completing write = Disabled
• Emulate modem hardware RING signal = 

Disabled
• Block PnP search for attached serial device 

= Disabled
• Clone = Disabled

COM 
Properties Description
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 Configuration Screens 
Device Properties Screen

You can change the default device 
name and starting COM port with 
the Device Properties screen. See 
Configuring Device Properties on 
Page 17 for configuration 
procedures. 
• Name: The Add New 

Hardware Wizard assigns a 
default name to each adapter. 
Use this field to enter a more 
descriptive name. The name 
that you assign is not saved 
until you click OK to exit the 
Main Setup tab. The new 
device name may not be 
present itself until the Device 
Manager is closed and 
reopened.

• Starting COM Port: You can 
change the starting COM port 
number in the drop list for this 
RocketPort EXPRESS, 
RocketPort EXPRESS SMPTE, 
and RocketPort INFINITY.
In addition, you can use Starting COM Port to set nonsequential starting COM 
port numbers for each adapter, thus leaving gaps in the COM port numbering 
sequence.
Note: When you change the starting COM port number, the driver assigns that 

COM port to the first port on this RocketPort EXPRESS, RocketPort 
EXPRESS SMPTE, and RocketPort INFINITY and all other port 
numbers follow in sequence. Do not overlap COM port numbers between 
devices or other RocketPort EXPRESS, RocketPort EXPRESS SMPTE, 
and RocketPort INFINITY adapters because if you do so, the 
overlapping ports are disabled.
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 Configuration Screens 
Options Tab

The Options tab contains the 
Verbose Event Log option, which 
causes detailed messages to be sent 
to the operating system Event Log. 
This added information can be 
useful when debugging 
communications and configuration 
problems.
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 Configuration Screens 
Port Settings Tab

The Port Settings tab for each RocketPort EXPRESS, RocketPort EXPRESS 
SMPTE, and RocketPort INFINITY COM port is accessed through the Device 
Manager under the Ports (COM & LPT) entry.
Use the Port Settings tab to configure standard COM port parameters. 

COM Port 
Parameters Description

 
Bits per 
second

Use this drop list to select the default 
application baud rate for the data to be 
transmitted through this port to the serial 
device. The default is 9600.

 
Data bits

If necessary, change the number of data bits 
to match the serial device connected to this 
port. The default is 8.

 
Parity

If necessary, change parity to match the 
error checking used with the serial device 
attached to this port. The default is None.

 
Stop bits

If necessary, change the stop bits to match 
the stop bits used by the serial device 
connected to this port. The default is 1.

 
 
 
Flow control

It is recommended that flow control be used 
to prevent data buffer overflow conditions.
Hardware flow control (RTS/CTS) is best 
because most modems default to hardware 
flow control.
Software (Xon/Xoff) flow control is used 
mostly by dot matrix printers and 
terminals where high data throughput is 
not critical.
The default is None.
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Configuring Non-Plug and Play Devices

After installing the hardware and driver for Windows 2000, you can use this 
discussion to configure modem COM ports.

Installing Modems

Use the following procedure to install modems on RocketPort EXPRESS, 
RocketPort EXPRESS SMPTE, and RocketPort INFINITY ports:
1. Connect the modem to the desired port.
2. Turn on the modem.
3. Open the Control Panel and double-click the Phone and Modem Options icon. 
4. Click Add. The Add/Remove Hardware Wizard starts.
5. Click Don’t detect my modem; I will select it from a list and then click 

Next.
Note: While Windows 2000 can automatically detect modems, we advise 

against using this option as auto-detect feature may cause some 
multiprocessor systems to lock up.

6. Click the appropriate manufacturer and model and then click OK. 
If the correct manufacturer and model do not appear on the list, click Have 
Disk to install software from a manufacturer-supplied installation diskette.

7. Click the port you to which you want to install the modem. 
8. Click Next. 
9. Click Finish. The modem software is installed on the selected ports.
Note: For help configuring modem properties, see the Windows Help system.
10. If you need to configure dialing properties (country, area code, calling card 

number, and so on), click the Dialing Rules tab, make the needed changes, then 
click OK.

11. Click Close when the Phone and Modem Options dialog reappears.
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Removing the Adapter and Driver

This discusses removing the device driver for the RocketPort EXPRESS, 
RocketPort EXPRESS SMPTE, and RocketPort INFINITY.
Use the following procedure to remove the existing device driver in your operating 
system.

1. Use the Device Manager to uninstall the RocketPort EXPRESS, RocketPort 
EXPRESS SMPTE, and RocketPort INFINITY driver.
a. On the Windows desktop, right-click the My Computer (or Computer) icon 

and then click Manage.
b. Click Device Manager.
c. Double-click Multi-port serial adapters to expand the view.

2. Right-click on the RocketPort EXPRESS, RocketPort EXPRESS SMPTE, and 
RocketPort INFINITY that you want to uninstall.

3. Click Uninstall and then click Ok to completely remove the adapter.
Note: Windows Vista users should click the check box to remove the software 

from the system on the last (or only) RocketPort EXPRESS, RocketPort 
EXPRESS SMPTE, and RocketPort INFINITY.

4. Exit the Device Manager and turn off the system.
5. REMOVE the adapter from the system before re-applying power.
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Troubleshooting and Technical Support

Troubleshooting

If you are having trouble with a RocketPort EXPRESS, RocketPort EXPRESS 
SMPTE, and RocketPort INFINITY, try the following.
Note: Most customer problems reported to Technical Support are traced to cabling 

or network problems.
1. Verify that you are using the correct types of cables in the correct places and 

that all cables are tightly connected. 
Refer to the appropriate RocketPort EXPRESS, RocketPort EXPRESS 
SMPTE, and RocketPort INFINITY User Guide or download the latest version 
(Page 5) to verify cabling.

2. Verify that the RocketPort EXPRESS, RocketPort EXPRESS SMPTE, and 
RocketPort INFINITY has installed using the Device Manager to confirm that 
the RocketPort EXPRESS, RocketPort EXPRESS SMPTE, and RocketPort 
INFINITY adapter displays.

3. After driver installation, if a port does not open; open the Device Manager, go 
to Ports COM & LPT. If a yellow exclamation mark represents the port, right-
click on the exclamation mark, and click Update Driver. See Updating the 
Driver on Page 9 for detailed procedures.

4. Verify that you are addressing the port correctly. In many applications, device 
names above COM9 require the prefix \\.\ to be recognized. For example, to 
reference COM20, use \\.\COM20 as the file or port name.

5. Run the RocketPort EXPRESS, RocketPort EXPRESS SMPTE, and 
RocketPort INFINITY diagnostics. The RocketPort EXPRESS, RocketPort 
EXPRESS SMPTE, and RocketPort INFINITY is shipped with a bootable CD 
that executes the hardware diagnostics. If necessary, you can download the 
Diagnostics .iso file and burn the bootable Diagnostics CD.

6. Enable the Verbose Event Log feature on the Options tab in the RocketPort 
EXPRESS, RocketPort EXPRESS SMPTE, and RocketPort INFINITY driver 
and then reboot the server. See Enabling Verbose Event Logging on Page 33 for 
procedures.

7. Install and use one of the tools in the Comtrol Utility package. The Comtrol 
Utility is available on the RocketPort EXPRESS, RocketPort EXPRESS 
SMPTE, and RocketPort INFINITY Software and Documentation CD or you 
can download the latest version. The file is a self-extracting zip file that 
automatically starts the installation procedure. It is not necessary to reboot 
the PC after installation.
The Comtrol Utility package includes the following applications that you can 
access from the Comtrol Program group:
• Test Terminal can be used to troubleshoot communications on a port-by-port 

basis. Test Terminal requires a loopback plug. You can build a loopback 
plug if you are missing the loopback plug shipped with the RocketPort 
EXPRESS, RocketPort EXPRESS SMPTE, and RocketPort INFINITY 
using the RocketPort EXPRESS, RocketPort EXPRESS SMPTE, and 
RocketPort INFINITY User Guide.

• Port Monitor checks for errors, modem control, and status signals. In 
addition, it provides you with raw byte input and output counts.

Use the following subsections for information and procedures to run Test Terminal 
tests.
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Test Terminal 
Explanation

This subsection provides background information about the two tests procedures 
in the following subsections.
• Send and Receive Test Data: This sends data out the transmit line to the 

loopback plug, which has the transmit and receive pins connected thus 
sending the data back through the Rx line to Test Terminal, which then 
displays the received data in the terminal window for that port. This test is 
only testing the Tx and Rx signal lines and nothing else. This test works in 
either RS-232 or RS-422 modes as both modes have transmit and receive 
capability. A failure in this test essentially prevents the port from working in 
any manner.

• Loopback Test: This tests all of the modem control signals such as RTS, DTR, 
CTS, DSR, CD, and RI along with the Tx and Rx signals. When a signal is 
made HI in one line the corresponding signal line indicates this. The Loopback 
Test changes the state of the lines and looks for the corresponding state 
change. If it successfully recognizes all of these changes, the port passes. 
A failure on this test is not necessarily critical as it depends on what is 
connected and how many signal lines are in use. For example, if you are using 
RS-232 in 3-wire mode (Transmit, Receive and Ground) a failure causes no 
discernible issue since the other signals are not being used. If the port is 
configured for use as either RS-422 or RS-485 this test fails and is expected to 
fail since RS-422 and RS-485 do not have the modem control signals that are 
present in RS-232 for which this test is designed.

Using Test Terminal 
to Test a Port

The following procedure shows how to use Test Terminal to send and receive test 
data to the serial ports and run a loopback test.
1. Stop all applications that may be accessing the ports such as RAS, RRAS, or 

any faxing or production software. See the appropriate help systems or 
manuals for instructions on stopping these services or applications. If another 
application is controlling the port, then Test Terminal is unable to open the port 
and an error message displays.
Note: Remember to restart the application once testing of the ports has been 

completed.
2. From the Start menu, click Programs > Comtrol > Utilities > Test Terminal 

(WCOM2).
3. Click File > Open Port and the appropriate port (or ports) from the Open Ports 

drop list.
4. Install the loopback plug onto the port (or ports) that you want to test.
5. Click Port > Send and Receive Test Data.

You should see the alphabet scrolling across the port. If so, then the port 
installed properly and is operational. 
Note: Click Port > Send and Receive Test Data to stop the scrolling data.

6. Click Port > Loopback Test.
This is a pass fail test and takes a second or two to complete. Repeat for each 
port that needs testing.

7. Close Test Terminal

If both of these tests successfully complete, then the port is operational as 
expected.
Note: Do NOT forget to restart the application.
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Enabling Verbose Event Logging

You can optionally enable the 
Verbose Event Log option on the 
Options tab for diagnostic 
purposes to initiate longer 
messages to be sent to the Event 
Log for your operating system. 
The added information can be 
useful when debugging 
communications and configuration 
problems.
Access the event log through the 
Administrative Tools Event Viewer 
option.
Use the following procedure to 
enable the Verbose Event Log 
option.
1. Use the Device Manager to 

open the RocketPort 
EXPRESS, RocketPort 
EXPRESS SMPTE, and 
RocketPort INFINITY driver.
a. On the Windows desktop, 

right-click the My Computer (or Computer) icon and then click Manage.
b. Click Device Manager.
c. Double-click Multi-port serial adapters to expand the view.

2. Double-click the RocketPort EXPRESS, RocketPort EXPRESS SMPTE, and 
RocketPort INFINITY for which you want to enable the Verbose Event Log.

3. Click the Options tab.
4. Select the Verbose Event Log option.
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Before calling Technical Support

Comtrol has a staff of support technicians available to help you. You should review 
Troubleshooting on Page 31 before calling Technical Support. If you call for 
Technical Support, please have the following information available.

Technical Support

If you need technical support, contact Comtrol using one of the following methods.

Item Information

Adapter type

Adapter serial number

Driver part number and 
revision or version

Server computer make, 
model, and speed

Other serial port adapters 
installed in the server and 
their COM port numbers

Devices connected to the 
adapter

Contact Method Corporate Headquarters

Support http://www.comtrol.com/pub/en/Support

Downloads ftp://ftp.comtrol.com/html/default.htm

Web site http://www.comtrol.com

Phone (763) 494-4100
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